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File Menu Commands

New
Opens an empty, untitled file window ready to accept icons.

Open
Used to access icons stored in files on your computer.    Icon Manager can access icons 
inside a variety of file formats including program files, dynamic link libraries, icon libraries, 
and icon resource files.

Close
Closes the currently active file window.    Icon Manager will prompt you to save any 
pending changes to the window before it is closed.

Save
Updates the currently active window to disk.

Save As...
Used to save the contents of the currently active window to a new disk file.    The new file 
can be written in any of the output formats supported by Icon Manager.    Select either the 
icon resource, icon library, or icon archive file format to control which type of file Icon 
Manager will output.    Icons can not be written to program or dynamic link library (*.EXE or
*.DLL) files.

Sounds...
This selection displays the Icon Manager Audio dialog control.    The dialog includes a 
Master Audio switch to turn all sound on or off.    Individual audio areas such as the sounds 
accompanying Windows' message boxes, and a "trash can" sound effect can be selectively
turned on or off.

Reconcile Installation
Icon Manager reconciles all icon resource files that it created to customize your Program 
Groups against your current configuration.    Icon files which are no longer required to 
support a Program Group are deleted from your disk at this time.

NOTE:    Icon Manager will not delete any files that you installed icons from, only the icon 
files that were created internally by the Install Icon dialog.

Exit
Closes the Icon Manager program.





Edit Menu Commands

Edit menu commands normally operate on the currently selected icon.

Copy icon to clipboard
Copies the bitmap information for the selected icon to the windows clipboard.

Delete icon from window
Removes the selected icon from the active window.

Rename icon...
Opens a dialog to accept a new description for the currently selected icon.

Create icon
Opens an OLE edit session with PaintBrush to create an icon.    The new icon is placed into 
the Tool window when completed.

Edit (xxx server)...
Opens an OLE edit session with PaintBrush for the selected icon.    See Editing Icons.

Install to Program Group...
Opens the Install Icon dialog allowing the icon to be installed to any application icon in 
Program Group.    This option will only be available if Icon Manager detects the presence of 
Windows Program Manager or Norton Desktop.



Window Menu Commands

Tile
Arranges open windows side by side so that all of them are visible.

Cascade
Arranges open windows so that the title bar of each window is visible.

Arrange Icons
Arranges all icons in the currently active window into evenly spaced rows and columns or, 
if a minimized window icon is selected, arranges the minimized window icons.

Close All
Closes all currently open files.    If any files have pending changes, Icon Manager will ask if 
a save should be performed before closing.

Tool Window
Toggles the Tool Window on and off.



Help Menu Commands

Contents
Used to enter Icon Manager Help at the Table of Contents

Seach for Help on...
Used to access Icon Manager Help by searching keywords.

How to Use Help
Use this selection to get Help on Windows Help.

About Icon Manager...
Displays a standard Windows "About..." dialog including the version level of Icon Manager 
and current memory and resource availability within Windows.



Selected Icon    -    Icon Manager allows you to select an icon within the currently active 
window for further operations.    The selected icon is denoted in one of two ways.    For 
icons that appear inside file windows that display descriptions of the icons (Icon Archive 
and Untitled Sheets) the icon's description is highlighted.    For all other windows, the icon 
is displayed with a dotted square surrounding it.



Introduction to Icon Manager

Welcome!
Whether you are a beginning Windows user or a seasoned veteran, Icon Manager will 
make gathering, organizing, maintaining and installing icons a breeze!

Icon Manager provides you with the capability to create, extract, organize, and install icons
on your system.    You can install any icon displayed in Icon Manager directly into a 
Windows Program Group.    Or, double-click on any icon to instantly invoke an OLE edit 
session with Windows PaintBrush.    All of the latest Windows' technologies have been 
exploited to bring you the best icon management application available!

Icon Manager Quick Start
Icon Manager's File.Open command will invoke the Open File dialog, providing access to 
icons stored in your Windows programs, libraries, and resource files.    You may select the 
file type you would like to open using the dialog's File Format control.    Icon Manager 
creates a window for each file, displaying all of the icons within the file.    The windows are 
similar to those found in Program Manager.    Icons can be dragged using the mouse within 
or between each of the file windows.    Hold the CTRL key down when beginning a drag 
operation to create a copy of the icon.

The File.New command will open a new, empty window ready for you to drag in the icons 
of your choice.    Use the File.Save As command to save any window in the file format of 
your choice.    Icon Manager will save files in the formats used by Icon Resource files 
(*.ICO), Icon Library files (*.ICL), and Icon Archive files (*.ICA).

Clicking on an icon with the right mouse button will select the icon and display a popup 
menu with a list of actions that can be performed on it.

A Few Brief Words About Icon Files
Icons are frequently distributed in the Icon Resource (ICO) file format.    Each ICO file 
contains a single icon.    Icon Manager will only allow the Icon Resource format to be 
selected during a File Save if the active window contains one icon.

Icon library files may contain multiple icons.    These files may have file extensions of ICL, 
IL, NIL, or DLL.    All of these files types share the same basic file format and are essentially
Windows Dynamic Link Library files.

The archive file type is a not a compressed file.    It is a structured file format used by Icon 
Manager to store icons.    The format provides for better organization (icon names and 
window positions can be saved along with the icon images) while using less disk space 
than the more common DLL and library files.





Opening Icon Files

Icon Manager will read and extract icons from a variety of file types.    Among the file 
formats that you can access with Icon Manager are Icon Resource files (ICO), Icon Library 
files (ICL, IL, NIL), Icon Archive files (ICA), Program Files (EXE), and Dynamic Link Libraries 
(DLL).

A file is opened by selecting the File Open command.    Icon Manager will display a common
Windows Open File dialog.    Use the File Format control in the lower left corner of 
this dialog to select the format of the file you wish to open.    Selecting a file format
will also reset the contents of the file listbox to display filenames of the type you have 
selected.

One extra feature has been added to the file open dialog.    When the Icon Resource (ICO) 
file format is selected, a checkbox labelled Open All will appear on the right side of the 
dialog.    Checking this option will instruct Icon Manager to open all of the ICO filenames 
appearing in the listbox (i.e., the currently selected directory) into one window.

Program and Dyanamic Link Library files are opened for reading only.    The icons in their 
windows can be copied to other files or installed in a Program Group, however the contents
of these windows cannot be altered.





Performing Operations on Icons

A variety of operations can be performed on icons using Icon Manager.    In most cases the 
operation is selected from one of Icon Manager's menus and is directed toward the 
selected icon in the currently active window.

Click once on the icon you wish to select for an operation.    If you prefer, use the 
keyboard's arrow keys to change the icon selection.    Press Ctrl-TAB to move to the next 
file window inside Icon Manager.

After selecting the icon you would like to work with, use the Edit menu on Icon Manager's 
main menu bar to choose the action you wish to perform.

TIP:
Mouse users can opt to click on the icon with either the left or the right mouse button.    
Clicking on an icon with the left button will move the selection highlight.    Using the 
right button performs the additional function of displaying a popup menu listing all of the
possible operations that can be performed on the icon.    The selections may include:

Edit (PBrush server)...    -    Opens an OLE edit session with the registered bitmap server. 
Windows Paintbrush (PBrush) is the default bitmap server in a new Windows installation.
Install to Program Group...    -    Opens the Install Icon dialog allowing the icon to be 
installed to any program item in a Windows Program Group.    This option will only be 
available if Icon Manager detects the presence of Program Manager or Norton Desktop.
Copy to clipboard    -    Copies the bitmap information for the icon to the windows 
clipboard.
Delete    -    Deletes the icon from the window.
Rename...  -    Opens a dialog that allows a new description to be entered.

All of the operations shown above appear on the main Edit menu.



Moving Icons Between Files

Moving or copying icons is performed exactly as it is in Windows Program Manager.    
Depress the left mouse button over any icon and move the mouse to drag it to another 
location.    Releasing the left mouse button will "drop" the icon at the new location.

While the icon is being dragged, the cursor will display a monochrome image of the icon 
whenever it is positioned on top of a legal drop area.    A circle with a slash is displayed 
when the cursor is over any area that the icon cannot be dropped on.    Valid drop areas are
within any window inside Icon Manager except those displaying Program or Dynamic Link 
Library files.

Icons can be copied instead of moved by depressing the CTRL key and the left mouse 
button to begin the drag operation.



Install Icon dialog

This dialog, activated from the Edit.Install Icon menu, is used to install the currently 
selected icon into a Program Manager or Norton Desktop group window.    Icon Manager 
makes the installation a breeze.    Just select the Program Group and Item that you want to 
update with the easy-to-use listbox controls.    Choose OK and let Icon Manager do the rest!

A copy of the icon is written to an icon resource file on your hard drive to support the 
installation in your shell application.

When Icon Manager installs an icon to a program group it also makes a record of this in a 
file named SHELL.DAT.    The SHELL.DAT file is used by Icon Manager when you select 
Reconcile Installation from the File menu.    The Reconcile Installation command instructs 
Icon Manager to attune all icon files it has created with the current state of your Program 
Groups.    Any icon files created by the Install Icon dialog that are no longer required are 
deleted to free up hard disk space.    Icon Manager does not delete any of your icon source 
files, only the resource files that it created to support the installation of an icon image into 
a Program Group.



Editing Icons

Icon Manager supports the editing of icons through the use of the Windows inter-program 
communication standards designed for Object Linking and Embedding, or OLE (pronounced
oh-lay' ).    What this means is that an edit session can be opened on any icon inside of 
Icon Manager by simply double-clicking on the icon.    A    double-click using the left mouse 
button is the standard action to begin an edit session on any object in an OLE client 
program.

To create a brand new icon, select the Edit.Create Icon command from Icon Manager's 
menu.

One shortcoming of Windows Paintbrush is that it does not allow for a transparent area to 
defined in the graphic.    Icon Manager overcomes this by prompting the user to choose a 
color to represent any transparent area (screen color) before beginning each edit session.   
The selected color is placed in the icon wherever the image is defined to be transparent.    
Icon Manager will place a reminder of the screen color in the menu bar of Paintbrush.

Icon Manager will open an edit session with the Windows Paintbrush application, PBrush.    
A reminder of the color you have chosen to represent the screen/transparent area of the 
icon is displayed in the main menu bar of Paintbrush.    Icon Manager will place Paintbrush 
into the "Zoom In" view for detailed editing.    You can toggle between the Zoom In and 
Zoom Out displays from the View menu.

The Paintbrush application will allow you to edit the icon as you like.    Although the icon 
image is relatively small, you will find that Paintbrush contains several powerful tools that 
can be used in the Normal view mode.    The color eraser can be used to change colors with
a stroke of the mouse.    Other drawing tools can be used to 'rough in' any original icon 
drawings before proceeding to the Zoom In view.

Using a zoomed view of an icon to establish the fine details is a must when editing an icon.
To switch to the zoom in view, select the View.Zoom In command from Paintbrush's menu, 
and then click the left mouse button over the icon image.    Only the brush and fill tools are
available in the Zoom In view of Paintbrush.    Fortunately these tools meet the needs of 
detailed drawing very well.    Remember, an icon is only 32 pixels tall and wide - every pixel
is significant in an image of this size.

Icon Manager will allow only one OLE edit session to be active at a time.    When you have 
completed your icon editing you should close the Paintbrush server application.    Any 
changes are reflected in the original icon whenever Update is selected from the File menu. 
If you have any outstanding updates that have not been sent to Icon Manager when you 
request Paintbrush to close, you will be prompted to choose whether the updates should 
be sent before exiting.

For more information on using PaintBrush, please refer to your Windows User's Guide.



Advanced Functions and the Tool Window

The Tool Window is most commonly used when creating a new icon.    Icon Manager will place
a copy of an icon created with a Paintbrush OLE edit session when the Edit.Create Icon 
command is selected.

Using the Tool Window to Import/Export
In most instances all icon editing can be accomplished through the use of Windows 
Paintbrush.    You may, however, have another editor that you prefer to use which supports 
the Windows clipboard.    Icon Manager allows you to copy an image of the icon to the 
clipboard to import it into your editor.    You can do this by clicking on the icon with the 
right mouse button and then selecting Copy from the popup menu.

After your edit is completed, pasting the image back into Icon Manager requires the use of 
the Tool Window.    Select Window.Tool Window to activate or remove the Tool Window from 
Icon Manager's display.    Select Edit.Paste from the Tool Window menu to paste an image 
from the Windows clipboard into the icon viewport area.    Copies of the new icon image 
can be dragged into any open window within Icon Manager.

More on the Tool Window

The Tool Window's Edit menu contains several other commands in addition to Paste.    The 
Tool Window will accept graphic images larger than the standard 32 by 32 size of a 
Windows icon when you select the Edit Paste command.    In this situation, scroll controls 
will be displayed on the right and bottom sides of the icon viewport.    The scroll controls 
are used to position the desired 32 x 32 pixel area of the image in the active area of the 
viewport.

The Edit Copy All command will place the entire contents of the current graphics image 
onto the clipboard while the Copy Viewport command restricts the copy to the visible 
image inside the viewport (32 by 32 pixels in size).






